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AGENDA

History
Create an image
Changing an image

Create SBS and/or depth map for

2D image



HISTORY

e 1956 Term Al was coined in 1956 at a conference at
Dartmouth College

* 1980s New coding toolkits and increased financial
investments gave Al a boost. Backpropagation
rediscovered.

* 1990s Machine learning: approach shifts from teaching
computers knowledge to giving them a lot of data and
letting them learn

* 2000s Unsupervised machine learning is developed

* 2010s Deep learning

* subset of Machine Learning that
constructs artificial neural networks to
mimic the human brain. Machine learning
become integral to many applications.

* Learning can be supervised, semi-
supervised, or unsuperwsed
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HISTORY - IMAGE
GENERATORS

2014 student at U of Montreal invents Generative
Adversarial Model (GANs)

The GAN Architecture
* 2 neural networks work against each

other N

lle-rda.!.tl
* One generates something to match
examples

* The other tries to distinguish real and
fake examp|es Discriminator real 1

* The fake detector pushes the fake Tid

“the art critic® take 0
generator to get better T Generator o = D

* Researchers at UC Berkeley used this to o | e | im¥
modify existing images
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2023

GENERATIVE PRE-TRAINED
TRANSFORMER (GPT)

2020s OpenAl invents ChatGPT and GPT-4

* large language models understand a prompt and
predict the words to respond.

 Consumes Tokens... computing resource related
to the number of words you feed it and the
number of words it produces. To use OpenAl
GPT-4 unlimitedly requires a subscription

 However, Microsoft Bing includes 15 GPT-4
qgueries per day for free

Intro to Al tools for 3D images
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BACK TO Al IMAGE
GENERATORS

* 2021 OpenAl announces DALL-E to create
images from a text prompt

“| think we'll see more aesthetic
exploratioryover the next three
years thap the past 200 years.”
» Diffusion models from physics are used in David Holz CEQof Al startup Midlourney
DALL-E 2 to learn how to remove noise
“We/got fast enough, cheap
enough, and most importantly
od enough to make this
accessible to everyone,

everywhere”
Emad Mostaque, CEO of Stability Al

2022 Breakthrough year according to people
in this industry. See quotes...
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CREATING AN IMAGE

Top three tools for creating images are:
e Midjourney

e https:/www.midjourney.com/app/

e DALLE (openai.com) or (bing.com/create)

e https://labs.openai.com
e https:/www.bing.com/create

° Stable Diffusion Al

e https://stability.ai

e (Can also be used to create 3D depth
maps
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CREATING AN IMAGE USING DALL-E

IS . Image Creator
BE MicrosoftBing  Q vl | L Ve

Simple to use '

Accessible from OpenAl’s web page
Jumpstart your creativity

AIternatiVEIy’ Can use MicrOSOft Bing The right words can be hard to find. Here

are a few ideas to get you started.

H Vibes / Mood
O u S e ) e S C r I e W a t y O U W a n t t O Try including a time of day, Try including a time of day, Try an illustration style, art
afeeling, or aesthetic. afeeling, or aesthetic. period or material

+ goidenhour  + playful + ssmmiens -+ wide angie + marble  + impressionism

see in the foreground, background,
the style you want, and any other
details, and hit the Create button.

P

The text you type is called a prompt O o e -
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CREATING AN IMAGE USING DALL-E ON BING
- EXAMPLE

Prompt:

create a Pixar-style chimp
hitting a baseball with a bat
while standing in a boat on a
river with mountains in the

background
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CREATING AN IMAGE USING

DALL-E ON BING - EXAMPLE

e Choose an image and
download it

* You can redo prompts to
get the output closer to
what you want
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CREATING AN IMAGE USING MIDJOURNEY

= [E] 3
S Midjourri?y y newbies-118 Bot room for n.. 2 = o Q) D 0
- b |
® Public
142+ new messages since 12:14 PM Mark As Read B

Vi v2 v3

© vsor lion and the lamb - Variations by @taylor (fast) g%

N Vidi ) BIB6T Today at 12:18 PM
lion and the lamb - Image #3 @taylor

Midjourney is the best of the breed as of today

Not an app, it’s a bot on the Discord app

* Discord is free software created in 2016 to le
gamers talk to each other while playing game

member-support

* Available on computers and mobile phones.
Helps to use both

newbies-118

my thread

* Anyone can create a server... an area where
you and others you let join can chat or talk

newbies-148

N _ "3 Make Variations Web [£
newbies-178

e Download Discord

e https://discord.com/download

dhe Midjourney server
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CREATING AN IMAGE USING MIDJOURNEY

- STEPS

Again, the text you type for an image is called a prompt ® oo >
For 25 free image generations
1.

2.

Discord — O
m v Midjourlé;y newbies-118 Bot room for n.. 3 < 2arch g J 0
5

202+ new messages since 12:14 PM Mark As Read B

V1 v2 v3 v4

2

&
I N g B @ v sor lion and the lamb ns by @taylor (fast) B
H idi Channels & Role - JTOT lTodayataz2 s en
Click on the Midjourney Server e lion and the Lamb ~ Image 1#5 (SIS

Click on one of the newbie rooms

Click in the prompt text box

member-support

Start typing “/imagine prompt”

newbies-118

my thread

A box should appear. Type your prompt there and hit
return

newbies-148
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CREATING AN IMAGE USING MIDJOURNEY -
PROMPTS

Midjourney prompt generator = (]

) https://www.viorelspinu.com/p/midjourney-prompt-generator.htmI?ref=futuretools.io o &8 A b W a3 = @
Viorel Spinu
Midjourney prompts can have MANY options, so:

Midjourney prompt generator

People have written prompt generators to help =

you get the perfect prompt f Midjourney Prompt Generator
L J
o g . . 'his weba enerates a Midjourney prompt from a text input and various options. Simply enter
¢ E ‘ g' M Id.! ou rnev prom pt g enerator (VI ore I spl nu 'Com) L= B the p:)[:ngpr andtthe dl\::ir]ed opni)[r)ls bei)tw and thte atpp inltl generare the gtomptsforf/:m t
e https:/www.viorelspinu.com/p/midjourney- T Prompt
prompt-generator.html?ref=futuretools.io = SRS e
cute cats wearing party hats
Documentation and user guides are available )
h ere Medium Lighting
*  Midjourney Documentation and User Guide : :
e https://docs.midjourney.com Painter
Vincent van Gogh Claude Monet Rembrandt Paul Cézanne
C ou I d a I SO use C h atG PT an d to ge ne rate t h e salvador Dali Pablo Picasso Henri Matisse Frida Kahlo
Frida Kahlo Johannes Vermeer Leonardo da Vinci Show All
prompt for you
Art Movement Rendering engine

“

Copy to clipboard
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CREATING AN IMAGE USING MIDJOURNEY
— RESULTS

N Midjourney Bot
’% vibrant california poppies

e After about a minute, you will get 4 images
that you can upscale or resubmit for
variations

e Clicking U1 will upscale image 1
e Clicking V1 gives you variations of image 1

* You can repeat this process until you're
happy with a final image

1
S

 Then just right-click and save the image.

2
4
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CREATING AN IMAGE USING MIDJOURNEY

- EXAMPLE

* Prompt:

e create a landscape, impressionism painting
of three laser-eyed dragons in the
foreground and a rocky mountain in the
background in the style of John Harris using
volumetric lighting with a vignette at 4K
resolution and 32-bit pixel depth --v 5 --
aspect 16:9
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DEPTH MAPS

A depth map is an image or image channel that
contains information relating to the distance of
the surface of scene objects from a viewpoint



DEPTH

Can create from a stereo pair:

* This allows a stereo image to be
converted to a 2D image and a
depth map

e Edit>Depth Map >Create
Depth Map from Stereo Pair
Can create from 2D image
* Loadimage
* File> Open Single Image

* Convert to 3D*

e Edit>Depth Map> Create
Depth Map from Single Image
* Requires installing Python & Google Al

MAPS - USING SPM

% (64bit) Image(Gemal create_a_landscape _impressionism_painting_of three laser- d14a6f44-91a5-424e-9b9d-5afdd2fd6912.png [1456 x 816]) (5/14)
File Edit View Web Help
-3 L1 =

Undo Buffer Clear Shift+Z

Copy Ctrl+C

Resize... R
Formatting... Shift+R
Crop >
Rotate/Flip Image >

Sharpen... U
Edge detection...

360 image
Add Text Ctrl+T
Add Logo Image Ctrl+L

Add Fuzzy Border Shift+B

Depth map Open Jpeg include depth map Ctrl+Alt+0

Ctrl+Shift+ Alt+D

Looking Glass Create depth map from Single Image(Google Al)
Lume Pad/Red Hydrogen One > Create depth map from stereo pair(Multi Conversion)

Create Lenticular Image... Reverse Depth map

Preferences...

Customize Toolbar...
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DEPTH MAPS — INSTALLING STABLE DIFFUSION

o a (O 127.0.0.1:7860 e AN % ] S
Also easy to use, but complicated to install :

Stable Diffusion checkpoint

sd-v1-5-inpainting.ckpt [c6bbc15e32] v B

Need to download and install the following Ertensions
1. Python, a code interpreter Instllec

Disable all extensions

1 1 Apply and restart Ul Check f dat:
2- Glt for W|ndOWS o g © none extra all
3. Automatic 1111 from GitHub i
4 I Q ff Q I f deforum-for-automatic1111-webui https://github.com/deforum-art/deforum-for-automatic1111-webui.git 5d7e0501 (Wed Mar 29 00:54:34 2023) | unknown
Sta b e d I u S I O n m O d e ro m ‘ stable-diffusion-webui-depthmap-script  https://github.com/thygate/stable-diffusion-webui-depthmap-script 33293791 (Tue Mar 14 16:39:44 2023) | unknown

LDSR built-in

HuggingFace.com

Edit a batch file o

Run the batch file

7. Enter IP address that the batch file gives e G - Gado RV
you into your web browser

8. Add stable diffusion extensions like

depth from within Automatic 1111

ol



Click
Depth
Tab

Drag
2D
image
here

Click
here

—

—)

DEPTH MAPS — USING STABLE DIFFUSION

() 127.00.1:7860

Stable Diffusion checkpoint

sd-v1-5-inpainting.ckpt [c6bbc15e32] v E

Single Image

[4 Source

Drop Image Here

Click to Upload

Generate

2023

Compute on Model

Depth

¢k QG @g -

Generate video from inpainted mesh.

¢ Video

Intro to Al tools for 3D images

[—

(Note the first
two tabs: you
can create
images from text
and modify
images with
other images
ON YOUR
COMPUTER)
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2023

DEPTH MAPS — USING STABLE DIFFUSION

Stable Diffusion — 5]

() 127.0.0.1:7860 ® A K O = & - @

a
Stable Diffusion checkpoint

sd-v1-5-inpainting.ckpt [cb6bbc15e32] - B8

Depth

Single Image

2|[%
Get 3D
G e
here
Generate
Compute on Model
O cru CcPU res101 g

Can create 3D images: side-by-side, 2D + depth map, anaglyph, top-bottom, heat maps
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2023

DEPTH MAP — INTERESTING POSSIBILITIES

Intro to Al tools for 3D images

Some ideas for using depth maps:
Modify them with Photoshop to:
1. Correct window violations

2. Give an image a depth map from a
different picture

3. Move an object closer or further away

4. Convert the image for use on other
devices or platforms (such as Looking
Glass Portrait, Facebook)
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2023

DEPTH MAP — INTERESTING POSSIBILITIES

Intro to Al tools for 3D images

Some ideas for using depth maps:
Modify them with Photoshop to:
1. Correct window violations

2. Give an image a depth map from a
different picture

3. Move an object closer or further away

4. Convert the image for use on other
devices or platforms (such as Looking
Glass Portrait, Facebook)
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2023

DEPTH MAP — FIXING WINDOWS VIOLATION

— T 1 — 1
9 | w

BEFORE IMAGE has windows CONVERTED to 2D + Depth Map
violation bottom center using SPM

Intro to Al tools for 3D images
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2023

DEPTH MAP — FIXING WINDOWS VIOLATION

CORRECTED DEPTH MAP AFTER IMAGE with correction
painting using Photoshop

Intro to Al tools for 3D images
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2023

2D TO 3D CONVERSION EXAMPLES

Al Image from DALL-E converted
using Stable Diffusion

Intro to Al tools for 3D images
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2D TO 3D CONVERSION EXAMPLES

Al Image from Midjourney converted
using Stable Diffusion
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2D TO 3D CONVERSION EXAMPLES

2D Photo downloaded from Bing Images
converted using Stable Diffusion
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2D TO 3D CONVERSION EXAMPLES

2D CGI Image downloaded from Bing
Images converted using Stable Diffusion
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SUMMARY

e Al tools are powerful and maturing FAST

e Some can be challenging to get running but are generally easy
to use

e They open creative avenues that were previously difficult or
impossible to accomplish

e Al can generate better-quality depth maps from 2D images

e Depth maps can help 3D photographers and image generators
fix or enhance existing images, or create completely new ones



THANK YOU

Gemal Seede
gemal@mumin.media

www.mumin.media

2023
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